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Upgrading from Suitcase Server Universal Type Server 

Upgrading from Suitcase Server 
Congratulations on your purchase of Universal Type Server™ font management software.  

This covers the main conceptual differences between Extensis Suitcase Server and Universal Type Server from 
an administrator’s perspective. We are confident that users will find the Universal Type Client™ both intuitive 
and easy to use. To quickly get users up to speed, it is recommended that each client user read the Universal 
Type Client Quick Reference. This short document covers the basic Type Client functions. 

 The following information will help you leverage your past server administration experience by applying what 
you already know to the administration of Universal Type Server™. This covers the conceptual differences 
between the two applications, as well as instructions that will help you preserve much of your users, fonts and 
other information. 

For complete information about the installation and configuration of Universal Type Server, see the Server 
Administration User and the Users and Workgroups Administration Guides and webhelp.  
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Quick Reference Chart 
Task Suitcase Server Universal Type Server

Enter default administrator 
username and password  

Default username: admin 
Default password: (blank) 

Default username: administrator
Default password: password 

Start, stop, pause the server Mac: Suitcase Server Launcher 
Windows: Administrative tools > 
Windows Services console 

Server Administration web 
interface via web browser 

Users (create, modify, assign 
permissions, delete) 

Server Administration Users and 
Groups dialog box 

Users and Workgroups 
Administration web interface via 
web browser 

Groups (create, modify, delete Server Administration Users and 
Groups dialog box 

Users and Workgroups 
Administration web interface 

Adding fonts Drag fonts to the Suitcase 
Server Administration dialog 

Users with permission to do so 
can drag fonts directly into the 
workgroup in the Type Client 

Mimic font delivery of Suitcase 
Server 

n/a Specify the font replication 
mode "all" for each user that it is 
required 
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Basic Conceptual Differences 
There are some fundamental differences between how Suitcase Server and Universal Type Server function. For 
complete details about each feature, see the Universal Type Server User Guides and webhelp.  

Workgroups and Sets  

Workgroups are a bit different than what you’ll remember from Suitcase Server. In Suitcase Server, groups 
were used to create distinct groups of users, and server sets were used to organize fonts. You would then add 
sets of fonts to groups so that users could subscribe to sets.  

In Universal Type Server, a workgroup is a ‘‘mini-database’’ that contains both users and fonts. Every user who 
is a member of a workgroup has access to all of the fonts within that workgroup without needing to 
‘‘subscribe’’ to anything.  

 Font Sets exist in one workgroup or another; they do not span workgroups. All users can create sets that are 
visible only to the user, yet with the proper permission a user can share sets with everyone in the workgroup.  

Users can be members of more than one workgroup, so you can continue to organize your fonts on a 
workgroup basis.  

Server Synchronization  

Server synchronization is also set at the server level from the Users and Workgroups Administration web 
interface. Synchronization is controlled by administrators on user-by-user basis. You can configure 
synchronization so that it functions like Suitcase Server where the client user chooses when to synchronize, or 
you can have the server synchronize automatically, from every 30 seconds to once a month.  

It’s important to note that Universal Type Server can be configured to optimize network performance by 
choosing the appropriate Font Replication Mode for each user. The default mode transfers fonts from server to 
client only when that font is required for preview or activation. 

You can configure Type Server so that it functions like Suitcase Server by choosing the Font Replication Mode 
of ‘‘All’’ for each of your users. This setting ensures that all fonts are downloaded to the client, whether or not 
the client has previewed and activated the font. Of course, clients will only download fonts from workgroups for 
which they are members. If you have a large number of fonts, this may not be the most efficient way of 
configuring your system.  

Permanently Active Sets  

Much like the Required Sets feature in Suitcase Server, if you want to require all users in a workgroup to 
activate a specific set of fonts in Universal Type Server, you can create permanently active sets. This feature 
allows administrators to create a set within a workgroup, add fonts to the set, and then make that set 
permanently active. This ensures that all members of the workgroup will have this set of fonts active on their 
system at all times. 

Importing Users  

If your organization uses Active Directory to manage users, you can use Active Directory or Open Directory as a 
source for your users.  

6 



Universal Type Server Upgrading from Suitcase Server

Duplicate Fonts  

Unlike Suitcase Server, if a font is a true duplicate, an exact copy exactly same font, it is not allowed in 
Universal Type Server. Through the use of a sophisticated font identification technology called Font Sense each 
font is accurately identified, and only one copy is kept on the server.  

For example, you might have a PostScript Type 1 and OpenType versions of a font. These are different formats 
and will likely have the same name, but are note true duplicates. However, if you have two or more copies of an 
OpenType, they would both be added only if some key font metadata was different, including the PostScript 
Name, Foundry, version number, etc.  

Font Licensing  

As with Suitcase Server, users with the appropriate permission can manage license information using the 
Universal Type Client. Licenses are created and then applied directly to fonts. Users can then search for fonts 
with specific licenses applied, as well as run reports for font licensing compliance.  

Server-Based and Client-Based Personal Workgroups  

In Suitcase Server, users could add fonts that were not added to the server and were only available to the local 
machine. The admin could limit a Windows user from adding any new fonts, but Macintosh users could add any 
fonts that they required. In Universal Type Server, you can specify if users are able to add fonts through the use 
of personal workgroup. Personal workgroups can be stored either on the user’s machine, or on the server. If 
the personal workgroup is stored on the server, the user can access his or her personal workgroup from any 
computer.  
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Web-based Administration Tools 
With Universal Type Server’s web-based tools, you can administer the server from a web browser on any 
computer, anywhere. Server administration is performed through two web-based interfaces: the Server 
Administration web interface and the Users and Workgroups Administration web interface.  

Server Administration web interface  

In the Server Administration web interface, you can manage the server, view connected clients, configure 
backups, and more. Through this interface administrators have a fine level of control over many things that were 
previously unavailable in Suitcase Server. Some of these features include:  

• Automated backup scheduling  
• Custom Bonjour naming  
• Viewing and forcing logoff of connected clients  
• Starting and stopping the server remotely  

To login using a supported browser: 

1. Enter your server IP address followed by a colon and the port number.  
The default server administration port is 8081 (also called the JBoss HTTP / Web Service port).  
Example: http://198.1.2.32:8081 or http://localhost:8081 

2. The default Server Administrator Super-user username and password are administrator and 
password.  

Users and Workgroups Administration Web Interface 

In the Users and Workgroups Administration web interface, administrators can manage users, workgroups, 
roles and permissions. Many of the tasks performed in this web interface were performed in the Users and 
Groups dialog box in Suitcase Server. Some of these tasks include:  

• Creating workgroups  
• Creating users and adding them to workgroups  
• Setting user permissions  

To login using a supported browser:  

1. In the location bar, enter your server IP address followed by a colon and the port number.  
The default Users and Workgroups Administration port is 8080 (also called the Jetty Web App port). 
Example: http://10.1.2.32:8080 (or http://localhost:8080 if administering the server locally).  

2. The default System Administrator Super-user username and password are administrator and 
password.  

Command line tools  

In addition to the administration web interfaces, many of the server administration functions can be performed 
through the use of command line tools. These tools can be helpful if certain administration functions are 
performed regularly, and would benefit from scripted automation. All command line functions are fully 
documented and include all parameters available to administrators. 
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New Permissions Structure 
In Suitcase Server, user permissions were set on a server-wide basis. This meant that users could access fonts 
and manipulate fonts in any set and group based on one set of permissions. Universal Type Server gives 
administrators a greater level of control because user permissions can be different in the context of each 
workgroup. As a result, users may not be able to perform the same activities in each workgroup to which they 
belong. For example, a user may be able to add and collect fonts in one workgroup, while in another 
workgroup only allowed to activate and deactivate fonts.  

The new permissions structure eases the process of setting up users and workgroups and provides more 
granular control. Key features include differences are:  

• Add, Delete, Collect: The ability to add, delete, and export fonts can now be controlled on a user-
by-user basis along with the ability to edit font information. 

• Roles for Easy Setup: Roles function like style sheets for users, allowing you to quickly and 
consistently set up multiple users. In addition, like style sheets, changes to roles dynamically update 
users assigned to that role. Universal Type Server comes with a variety of roles, you can create your 
own roles, and you can override a role’s settings on a user-by-user basis. Workgroups have a 
default role so you can add users to a workgroup without setting up their individual permissions.  

• User Permissions Can Vary by Workgroup: You can give users different roles, permissions, and 
settings in different workgroups. As a result, users may not be able to perform the same activities in 
each workgroup to which they belong.  

You do still have the option to give users different levels of administration permissions. Users can be given the 
Font Administrator role, and this is basically the equivalent of the Font Administrator user permission in Suitcase 
Server. The font administrator status does not have to apply to all workgroups to which the user belongs-----so a 
user might be a font administrator in one workgroup and not in another. To give users the equivalent of the 
Server Administrator permission, in Universal Type Server enable the Is Full Administrator permission in the 
user’s Settings tab from the Users and Workgroups Administration web interface.  
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Comparing User Settings and Permissions 
The Users and Workgroups Administration web interface allows you to create users and specify a role or 
individual settings and permissions. The following table shows you where many of the Suitcase Server 
equivalent permissions can be located. It’s important to note that permissions listed on the Global tab can also 
be applied on a workgroup by workgroup basis by choosing each workgroup name in the Workgroup tab. 

Suitcase Server User  
Permission 

Universal Type Server 
Permission or Setting 

Universal Type Server 
Location 

Full Name  Full Name Account tab 
User Name  Account name Account tab 
Password  Password Account tab 
User can create new local sets  n/a - all users can create sets 

within workgroups 
n/a

User can collect fonts for output  Collect Fonts for Output Global tab
User can add local fonts  Has Personal Workgroup Settings tab 
User can deactivate 
Required/Activated fonts 

n/a --- if a an administrator makes 
a set permanently active, all fonts 
in that set cannot be deactivated.

n/a

User can add local fonts 
temporarily  

n/a there is no direct equivalent 
of temporary fonts. Users may 
add fonts to personal 
workgroups to use fonts without 
sharing them with an entire 
workgroup. 

n/a

User can add/remove keywords 
and styles  

Keywords; Styles, Classifications, 
Foundries and Families  

Global tab

User can override system fonts  n/a --- To avoid font conflicts, 
system fonts cannot be 
overridden.  

n/a

User can use auto-activation  n/a --- all users can utilize the 
Universal Type Server auto-
activation plug-ins. 

n/a

Update at startup Client synchronization is 
controlled using synchronization 
and font replication settings. 

Settings tab 

User can assign/unassign 
keywords and styles  

Keywords; Styles, Classifications, 
Foundries and Families  

Global tab

User can manage system fonts  n/a --- User cannot manage 
system fonts  

n/a

User can save finds  n/a --- All users can create smart 
sets that automatically execute 
saved find settings  

n/a

Font Administrator  Font Administrator Role Roles pane  
Server Administrator Is Full Administrator Settings tab 
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Additional New Items 
The following additional improvements are also included in Universal Type Server. 

Universal Type Client and Administrative Tasks 

While the majority of Type Server administrative functions are performed through the Server Administration and 
Users and Workgroups Administration web interfaces, there are a number of administrative tasks that can be 
performed directly through the Universal Type Client interface.  

In general, if the administrative task requires interacting with fonts, the action will be performed directly from the 
Type Client. Some of these tasks include:  

• Creating permanently active sets 
• Creating and adding font licenses  
• Running font licensing reports  

Networking Requirements 

The Universal Type Server requires a number of open ports for both internal server communication and client 
connection. Most importantly, to connect to the Server Administration web interface, port 8081 must be open, 
and to use the Users and Workgroups Administration web interface, port 8080 must be open. These ports can 
be changed as required using the Server Administration web interface.  

As an additional benefit, Type Server uses the Apple Bonjour technology to support network discovery of font 
servers. This way, even if your users forget the server address, they will be able to browse servers on the 
network to quickly find the location of your server. The Bonjour technology is supported for both Mac and 
Windows clients and server installations.  

Auto-Activation Plug-ins 

The Universal Type Client auto-activation plug-ins are improved over those available for the Suitcase X1 client. 
The new plug-ins include many features that were previously unavailable, including: 

• Font Sense based font activation uses sophisticated font identification techology to always activate 
exactly the right font. Once you save a document with the Universal Type Client auto-activation 
plug-ins, Font Sense metadata is saved right into the document, ensuring that any user who opens 
the document will always use the correct fonts.  

• You can create a set of the fonts used in a document right from the plug-in.  
• The new plug-ins allow you to go offline without using the Universal Type Client to do so. 
• If you open a document that uses the plug-ins and you are not currently logged in to the server, the 

plug-ins will allow you to login directly without needing to launch the Type Client.  
• The ability to activate only fonts from a single workgroup. This way you can use fonts only in a 

known, approved Type Server workgroup, and not inadvertently use fonts not intended or licensed 
for other use.  

The Universal Type Core 

One very important difference between the Suitcase Server client and the Universal Type Client is that to keep 
fonts active, you do not need to keep the client running. The Universal Type Client uses a background 
application called the Universal Type Core to keep fonts active. Once logged in to the server, your users can 
quit the Type Client, and fonts that are activated will stay active. If you user opens a document that requires 
inactive fonts, the auto-activation plug-ins communicate directly with the Type Core and activate the required 
fonts.  
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Suitcase Server Migration Process 
If you have a previous installation of Suitcase Server, you may want to use the Suitcase Server Migration Tool to 
help move your data from your previous server into Universal Type Server.  

Configuring Type Server from scratch  

While Extensis provides the migration tool for your convenience, this may be a good time for you to reexamine 
your font management requirements, and configure Universal Type Server to most accurately meet your needs. 
There are several differences between Suitcase Server and Universal Type Server that could affect your 
configuration decisions. Most of the changes are covered in this document. We recommend that you read the 
Type Server documentation for complete configuration and setup instructions.  

Backup any current installation  

Before starting the migration process, back up Suitcase Server as well as any previously configured Universal 
Type Server database. 

If you have already installed and configured Universal Type Server, it is important to understand that all 
current users, workgroups, fonts and roles are replaced with new data during the migration process. If 
users have added fonts and created sets that they would like to retain, instruct users to export fonts using the 
File > Collect Fonts for Output command before beginning the migration process.  

Migrating from Suitcase Server 

Before taking the steps to migrate your server, it is a good idea to make sure that your current installation is in 
good working order. Take a few moments to remove any unnecessary users, groups and sets. This will help 
keep your Universal Type Server installation clean from the start, and only migrate the data that you really need. 

It’s also important to note that if you choose to use the migration tool, any existing data that you have already 
configured in your Universal Type Server installation will be lost. 

To be most effective, the migration tool must be used at the start of the configuration process.  

Suitcase Server Migration Tool System Requirements 

• Suitcase Server 11.0.0 
• Mac OS 10.4 or higher  
• Hard disk space equal to double the size of your current font library  

While the Suitcase Server Migration Tool must be run on a Mac OS X machine, the tool will work on databases 
that reside on either Mac or Windows servers. 

NOTE: If you are working in an environment with only Windows clients, Extensis recommends that you rebuild 
your server database from scratch. Otherwise, Extensis Integration and Consulting Services (ICS) may also be 
able to help with your upgrade process, contact Extensis Corporate Sales for more information.  

During the migration process, all fonts, users and workgroup data are downloaded from the server. The tool 
then creates a TAR archive file of your data that is used to create the new Type Server database. This is why 
the machine on which you run the migration tool must have at least double the space required to store your 
entire database.  
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Preparing Suitcase Server 

For the migration tool to function properly, all users must be logged off and not using Suitcase Server. The 
easiest way to do this is to stop and restart the server. The Suitcase Server must be running with no users 
connected for the migration tool to be successful.  

1. Notify all users to log off Suitcase Server.  
2. For Macintosh servers, from the machine that is running Suitcase Server, open the Suitcase Server 

Launcher.  
Click Stop then click Start to restart the server.  

3. For Windows servers, open the services window from the control panel. Double-click the Suitcase 
Server icon and in the Service Status area of the dialog box. 
Click Stop then click Start to restart the server. 

The Suitcase Server Migration Tool 

The migration tool steps you through the process of migrating much of your existing Suitcase Server database 
into a Universal Type Server backup .TAR file.  

1. Double-click to launch the Suitcase Server Migration Tool.  
2. In the Output folder field enter a location where you want to place the output TAR file, or click the 

Browse button and navigate to a location on the local disk. 
3. In the Server Authentication dialog box, enter the server IP address or DNS name, or alternately, 

click Locate Server and navigate to your Suitcase Server. If you are running the migration tool 
locally on the server, enter localhost in this field. 

4. Enter the username and password of any Suitcase Server administrator. 
5. Click OK to begin the migration process. It may take a long time to download all of the data and 

build the backup TAR file that you will use to restore in Universal Type Server. 
6. Fonts that are unable to be migrated are placed in a folder named Unmigrated fonts in the same 

location as the TAR archive. These include Windows-only PostScript fonts as well as fonts that may 
be considered corrupt. After restoring the archive, re-add Windows-only fonts using the Windows 
version of the Universal Type Client.  

Restore the TAR backup 

After running the migration tool, the result is a .TAR backup file. To bring your Suitcase Server data into 
Universal Type Server, you must use the Universal Type Server’s Server Administration web interface to restore 
the backup. 

1. Copy the .TAR backup file to the machine running Universal Type Server. 
2. Open the Server Administration web interface. The default server location is port 8081. For example:  

http://10.1.5.95:8081 
http://localhost:8081 

3. Click the Backups link. 
4. In the Restore from backup file field, enter the path to the .TAR backup on your server. For 

example:  
C:\Program Files\Extensis\Universal Type 
Server\data\backups\mybackup.tar 

5. Click Restore datastore.  
WARNING: This overrides all previously entered data, including fonts, users and workgroups in 
Universal Type Server.  
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Reset the Server Administration Super-User Password 

After restoring the .TAR file, the Server Administration Super-User password is reset to the default username, 
‘‘administrator’’ and password, ‘‘password’’. To change this password:  

1. Open the Users and Workgroups web interface. The default server location is port 8080. For 
example:  
http://10.1.5.95:8080 or  
http://localhost:8080  

2. Login using the default Super-user account name and password.  
3. In the Users pane, select the Administrator account. 
4. In the Details pane, click Edit.  
5. Enter a new password and click Update.  

Keep a record of the new password for future use. 

Collect Local Fonts and Add to Personal Workgroups 

When using Suitcase Server, users could be given the permission to add fonts from their local machine. Mac 
OS X users required the Manage Local Fonts permission, and all Windows users were able to add fonts from 
their machine. Since these fonts were never added to the server, the fonts cannot be automatically migrated to 
the new Universal Type Server installation. Local fonts must be manually migrated by each client user.  

Before you tell users to migrate fonts, if you don’t want all of your users’ local fonts added to the server 
database, be sure to enable the Has Personal Workgroup setting for all users who need permission to add 
fonts locally. Personal workgroups can be stored either on the Type Server, or locally on the user’s machine. 
Either setting restricts use of fonts in the personal workgroup to each user.  

Collecting Local Font on Mac OS X  

If a client user has created a number of sets, to migrate fonts while preserving set groupings, use the following 
procedure. 

1. Using the finder, create a main folder that will contain all of the local fonts. 
2. In that folder, create a sub-folder for each set that you want to preserve. 
3. In Suitcase X1, select a set and choose Tools > Collect for Output. 
4. Navigate to the appropriate sub-folder and click Collect. 
5. Repeat steps 3-4 for all sets required.  
6. Quit the Suitcase client. 
7. Launch the Universal Type Client. 
8. Open the main set folder and drag all of the sub-folders into the Personal Workgroup in the 

Workgroups pane. Dragging each set folder into the Personal Workgroup creates a set for each 
folder.  

Collecting Local Fonts on Windows  

To move fonts that were added locally, you must first know where the fonts reside. In Suitcase for Windows, 
fonts can either be added to the vault, or in place from their current location.  

If the font files are stored in the vault, the file path in Suitcase for Windows will indicate ‘‘Vault,’’ and if added in 
place, the font’s physical location on the disk is displayed. If font files are added in place, drag the folder 
containing fonts from the explorer into the Personal Workgroup in Universal Type Client. Otherwise, if the fonts 
are stored in the vault, you will need to drag the files directly out of the vault location into the Personal 
Workgroup.  

If the font files are stored in the vault on a Windows XP machine, the vault is located here, where <username> 
refers to the current user’s Windows username: 

C:\Documents and Settings\<username>\Application 
Data\Extensis\Suitcase\Suitcase Font Database.suitcasevault\ 
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NOTE: If you are unable to locate the Application Data folder, it is likely that you don’t have your system set to 
display hidden folders. To show this, from the Windows Explorer, choose Tools > Folder Options. In the 
Advanced Settings area of the View tab, enable the option to Show Hidden Files and Folders. 

If the font files are store in the vault on a Windows Vista machine, the files are located: 

C:\Users\<username>\AppData\Roaming\Extensis\Suitcase\Suitcase Font 
Database.suitcasevault\  

NOTE: If you are unable to locate the AppData folder, it is likely that you don’t have your system set to display 
hidden folders. To show this in Windows Vista, choose Start Menu > Control Panel > Folder Options. In the 
Advanced Settings area of the View tab, enable the option to Show Hidden Files and Folders.  

What is Migrated from Suitcase Server? 

Users 

Suitcase Server Universal Type Server
User account name and 
password 

Users will all have the same account name and password in Universal 
Type Server as they had in Suitcase Server. 

Admin account  The default admin account in Universal Type Server is the 
administrator account with a default password of ‘‘password’’. Use this 
new user account for the top level of server administration. Be sure to 
change the default password as soon after installation as possible.  

Server Font User 
permission  

Users who had the Server Font User permission are given the Regular 
User role in workgroup that they are members. Associated permissions 
that most closely match previous Suitcase Server settings are also 
selected. 

Font Administrator 
permission 

Users who had the Font Administrator permission in Suitcase Server 
are given the Font Administrator role in workgroups to which they are 
members. 

Server Administrator 
permission 

Any user who had the Server Administrator permission in Suitcase 
Server is automatically given the Font Administrator role in workgroups 
to which they are members. To enable more robust Type Server 
control, you may want to enable the Full Administrator setting for select 
users.  

Groups 

Suitcase Server Universal Type Server
Groups A new workgroup is created in Type Server for each group in Suitcase 

Server. The default role for each workgroup is automatically set to 
Regular User. 

The "All Users" Group If your Suitcase Server configuration included sets assigned to All 
Users, a new workgroup in Type Server named Suitcase Server --- All 
Users is created. This workgroup contains all users, as well as fonts 
from sets previously assigned to the group. 
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Fonts 

Suitcase Server Universal Type Server
All Suitcase Server Fonts All fonts that were stored in Suitcase Server, including fonts that were 

not assigned to a group, are included in a new workgroup named 
Suitcase Imported Fonts. 

Font ownership Fonts that are migrated from Suitcase Server are labeled as Added by 
the administrator. 

Windows only fonts Since the migration tool runs in Mac OS X only, Windows-only fonts, 
such as Windows PostScript Type 1 fonts cannot be adequately 
checked for corruption. Any Windows-only fonts are placed by the 
migration tool in a folder named Unmigrated Fonts in the same folder 
as the TAR backup. To ensure that these fonts are valid, re-add them 
using the Windows Universal Type Client. 

Sets 

Suitcase Server Universal Type Server
Sets All Suitcase Server sets are created within new Type Server workgroups 

based on how the sets existed within Suitcase Server groups.  
Set ownership Sets that are created by the migration tool are labeled as Created by 

the administrator. 
Sets in multiple groups Sets that were in multiple groups in Suitcase Server are duplicated 

across multiple workgroups in Type Server.  

What is not migrated 

Licenses 

The method of license tracking used by Suitcase Server doesn’t directly map over to the new licensing 
structure. Before running the migration tool, be sure to take a manual assessment of your licenses and then 
recreate those in Type Server. 

Keywords and custom font attributes 

Custom font attributes, including keywords, classifications, etc. entered into the Suitcase client are not available 
for migration. This is because in the Suitcase Server method, font attribute data was stored on the user’s local 
machine. In Universal Type Server, this data is stored at a server level, ensuring that all users have access to 
the same font attribute information. 


